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Abstract 

The corticospinal tract (CST), which carries commands from the cerebral cortex to 

the spinal cord, is vital to fine motor control. Spinal cord injury (SCI) often damages CST 

axons, causing loss of motor function, most notably in the hands and legs. Our preliminary 

work in rats suggests that CST circuitry is complex: neurons whose axons project to the 

lower cervical spinal cord, which directly controls hand function, also send axon collaterals 

to other locations in the nervous system and may engage parallel motor systems. To inform 

research into repair of SCI, we therefore aimed to map the entire projection pattern, or 

“connectome,” of such cervically-projecting CST axons. In this study, we mapped the 

corticospinal connectome of the Rhesus macaque - an animal model more similar to 

humans, and therefore more clinically relevant for examining SCI. Comparison of the 

Rhesus macaque and rat CST connectome, and extrapolation to the human CST 

connectome, may improve targeting of treatments and rehabilitation after human SCI. 

To selectively trace cervically-projecting CST motor axons, a virus encoding a Cre-

recombinase-dependent tracer (AAV-DIO-gCOMET) was injected into the hand motor 

cortex, and a virus encoding Cre-recombinase (AAV-Cre) was injected into the C8 level of 

the spinal cord. In this intersectional approach, the gCOMET virus infects many neurons in 

the cortex, but gCOMET expression is not turned on unless the nucleus also contains Cre-

recombinase, which must be retrogradely transported from axon terminals in the C8 spinal 

cord. Thus, gCOMET is only expressed in neurons that project to the C8 spinal cord, and it 

proceeds to fill the entire neuron, including all axon collaterals. Any gCOMET-labeled axon 

segments observed in other regions of the nervous system are therefore collaterals of 

cervically-projecting axons. gCOMET-positive axons were immunohistochemically labeled, 
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and axon density was quantified using a fluorescence microscope and Fiji/ImageJ software. 

Specific regions of interest were chosen for analysis because of their known relevance in 

motor function in humans, and for comparison to results of a similar study in rats. Results in 

the first monkey have revealed both similarities and differences between the monkey and 

rodent CST connectome. Analyses of additional monkeys are ongoing. The final results will 

provide detailed information about differences between rodent and primate CST, will serve 

as a baseline for examining changes in the CST connectome after SCI, and will provide 

guidance for studies targeting treatment and functional recovery after SCI. 

 

Introduction 

Spinal cord injury is a serious medical problem that currently affects approximately 

288,000 people in the United States, impacting about 17,700 new cases each year (National 

Spinal Cord Injury Statistical Center, 2018). Of people affected by traumatic spinal cord 

injury, 47.2% suffer from incomplete tetraplegia and 11.5% suffer from complete tetraplegia 

(National Spinal Cord Injury Statistical Center, 2018), which is associated with the loss of 

muscle strength and sensation in all four extremities and the torso. Unfortunately, there is 

currently no treatment that is able to reverse damage and regenerate axons in the adult 

central nervous system to improve function.  

The CST is critical for fine motor function and is therefore a prime target for therapy 

after SCI. The CST is a pathway made up of upper motor neurons originating from the 

motor cortices that coordinate the activity of the lower motor neurons in the ventral horn of 

the spinal cord. These lower motor neurons innervate the muscle fibers of the muscle 
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intended for movement, making the CST crucial in motor function. Damage to the CST 

depends on the location of the damage but generally diminishes motor function. Lesioning 

of higher areas like upper motor neurons may result in paralysis, decreased reflexes, 

decreased muscle tone due to atrophy, and fasciculations and fibrillations. While lesioning 

to lower motor neurons may result in weakening, spasticity, and loss of fine voluntary 

movement. Because the CST is particularly important in distal forelimb movement (such as 

fine finger function), CST repair could substantially increase independence of the patient if 

improved (Lang, C. & Schieber, M., 2004). 

As observed in a previous study of the rat connectome (Conner, M., Ovruchesky, E., 

Takashima, Y., Biane, J., Gibbs, D., & Tuskynski, M., manuscript under review), the CST is 

actually more complex than homogeneous axon projection to the spinal cord. Instead, CST 

axon collaterals also terminate in other areas of the brain such as the subthalamic nucleus 

and the thalamus. Understanding the complexity of these collateral projections from the 

primary motor cortex may allow us to better shape treatment after SCI.  

Recent studies have shown promising advancements in SCI treatment by utilizing 

neuronal progenitor cell grafts implanted into the spinal cord in specifically targeted areas of 

the CST associated with distal hand function. One of these studies in rats was successful in 

obtaining results of a surviving human multipotent neural progenitor cell graft in the spinal 

cord which promoted axonal regeneration and improved skilled forelimb function (Kadoya, 

K., et al., 2016). Following similar protocol, studies within the Rhesus macaque were 

unsuccessful in graft survival. However, graft survival was accomplished once 

immunosuppressant drug levels and growth factor cocktail concentrations were increased, as 

well as tilting of the operation table immediately after grafting to drain cerebrospinal fluid 
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from the lesion site. The graft consisted of human multipotent neural progenitor cell graft 

implanted into the hemisection lesion site at C7 in the Rhesus macaque. Monkeys with 

surviving grafts exhibited >25% recovery in object manipulation scores in 4 out of the 5 

subjects and had significantly greater peak right-hand object manipulation scores than 

monkeys without grafts (Rosenzweig, E., et al., 2018). This discrepancy in graft survival 

between the rat and monkey for improvement of distal forelimb function highlights the 

physiological differences in the two animals, which prompts the necessity of studies in 

larger animal models for clinical relevance application in humans. 

Given the promising breakthrough of graft survival in Rhesus macaque, the next step 

is specifically targeting regions in the CST with substantial roles in voluntary movement. A 

study mapping the corticospinal projections associated with distal forelimb control in rats, 

otherwise known as the rat connectome, provided a preliminary protocol and comparative 

baseline for subsequent studies in larger animal models (Conner, M., Ovruchesky, E., 

Takashima, Y., Biane, J., Gibbs, D., & Tuskynski, M., manuscript under review). Similar 

methods to the rat connectome project were used in this present study to curate a 

connectome of cervically projecting corticospinal tract motor axon collaterals in the Rhesus 

macaque. Results may bring to light regions of relevance in motor function, defined by the 

total sum of innervating axons within the area, which may allow for specific targeting in 

SCI treatment and functional recovery. These regions of interest from the Rhesus macaque- 

a facultative bipedal, larger animal model- may more closely represent the areas relevant for 

human motor function. Therefore, allowing for closer clinical relevance in targeting areas 

for treatment, as well as providing an established baseline of normal axon density to 

compare to post SCI for direction of rehabilitation.  
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Materials and Methods 

Subjects 

The subject tested was a male Rhesus macaque (Macaca mulatta) raised at the 

California National Primate Research Center of University of California Davis. All surgical 

and experimental procedures adhered to the principles outlined by the American Association 

for the Accreditation of Laboratory Animal Care and were approved by the Institutional 

Animal Care and Use Committee at the California National Primate Research Center of 

University of California Davis. The subject had not participated in any previous studies and 

was sacrificed and perfused at the age of 9 years. Tissue processing was then performed at 

the Center for Neural Repair at the University of California San Diego. 

 

Corticospinal Tracing 

Performed at the University of California Davis, a virus encoding a Cre-

recombinase-dependent-tracer (AAVdj-DIO-gCOMET) was injected into the hand motor 

cortex so that gCOMET anterogradely infected all neurons and axon collaterals projecting 

from the motor cortex (Fig. 1). A virus encoding Cre-recombinase (AAV-Cre) was injected 

into the C8 level of the spinal cord, which directly controls hand function. Only neurons 

with nuclei containing both gCOMET from the motor cortex and AAV-Cre, which is 

retrogradely transported from the C8 of the spinal cord, has activation of the expression of 

gCOMET which ensures selective tracing of cervically projecting CST motor axon 

collaterals.  
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Figure 1. 

Intersectional corticospinal tracing method. AAV-Cre, represented in blue, is the virus 

encoding Cre-recombinase, and the AAVdj-DIO-gCOMET, represented in green is the Cre-

recombinase dependent tracer. The AAVdj-DIO-COMET is injected into the hand motor 

cortex and the AAV-Cre is injected into the C8 of the spinal cord to selectively trace 

cervically projecting corticospinal tract motor axons collaterals (Rosenzweig, E.) 

 

Tissue Preparation 

The Rhesus macaque tissue shipped to University of California San Diego from 

University of California Davis consisted of the brain, brainstem, and spinal cord. The brain 

was cut into three blocks after being frozen in methylbutane cooled in dry ice. Once cut into 

blocks, the tissue was sectioned on a microtome into 40 µm coronal sections. Every 12th 

section was used for analysis, while the rest was stored at -20°C in Transfected Cell 

Selection Medium. 
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Immunofluorescent Labeling  

The sections were immunohistochemically stained for Green Fluorescent Protein 

(GFP), while Neuronal Nuclei (NeuN). GFP labeled all cell bodies and axons infected by 

both gCOMET and AAV-Cre and NeuN labeled all cell bodies. First the tissue was washed 

three times in Tris-Buffered Saline (TBS) for ten minutes each. Then, to increase 

permeability to antibodies, the tissue was treated with 50% methanol diluted in TBS for 5 

minutes, 100% methanol for 30 minutes, and 50% methanol a second time for 5 minutes. 

Sections were then washed with TBS three times for 5 minutes each. Non-specific binding 

was blocked with TBS plus 0.25% Triton X-100 and 5% Donkey serum (TBS++) and was 

left for 1 hour. The tissue was then incubated in primary antibodies against GFP (Chicken, 

1:2000)  and NeuN (Mouse, 1:2000) which were diluted with TBS ++ (1:2000), overnight at 

4°C, and then washed with TBS three times at 10 minutes each. Tissue was then incubated 

for 2 hours at room temperature with a secondary antibody containing 568 conjugated 

donkey anti-chicken (1:500)  and 647 conjugated donkey anti-mouse (1:500) diluted in TBS 

++. DAPI (4′,6-diamidino-2-phenylindole) nuclear stain (1:1000) was subsequently added 

for 5 minutes at room temperature, before the tissue was washed with TBS three times for 

10 minutes each. Finally, the tissue was mounted onto gelatin subbed slides and 

coverslipped with Mowiol. 

 

Fluorescence Microscope Imaging 

Images of regions of interest (ROIs) of the Rhesus macaque were captured using a 

Keyence BZ-X710 All-in-One Fluorescence Microscope. Regions of interest included the 
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subthalamic nucleus, the thalamus, the zona incerta, the reticular tegmental pontine nucleus, 

the pontine grey, the caudate, the putamen, the red nucleus, and the superior colliculus. 

These specific regions of interest were chosen because of their known motor function 

relevance and for comparison to areas of import in a preliminary connectome experiment 

performed in rats. The regions of interest were imaged for GFP and NeuN at 20x 

magnification.  

 

Photoshop Enhancement 

Adobe Photoshop was utilized to enhance the cervically-projecting axons, labeled 

with GFP (green), from the background components such as neuronal cell bodies, labeled 

with NeuN (red), from the images captured with the Keyence BZ-X710 All-In-One 

Fluorescence Microscope. To enhance the GFP and decrease the NeuN visible, first the 

“Hue and Saturation” of “Yellow” was decreased to zero to remove background noise. The 

“Levels” feature for “RGB” and for “Green” were then increased to amplify the GFP. “Hue 

and Saturation” of “Red” and “Yellow” were decreased to zero to further remove 

background noise and the signal from the red NeuN labeling of the neuronal cell bodies. The 

enhancement of axons from background noise allowed for more effective quantification of 

the axons in subsequent stages of analysis.  

 

Quantification of Summed Axon Length  

Fiji/Image J software was utilized to analyze the Photoshopped images of the ROIs. 

First, the free hand tool was used to outline the ROIs on the original  images captured with 

the Keyence BZ-X710 All-In-One Fluorescence Microscope and then stored in the ROI 
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Manager. The outlines of the ROIs were determined by cross referencing between online 

resources, Brain Maps (http://brainmaps.org) and Scalable Brain Atlas (Dubach, M.F. & 

Bowden, D.M., 2009), and “The Rhesus Monkey Brain in Stereotaxic Coordinates” 

(Paxinos, G., Huang, X. & Toga, A. W., 1999). The Photoshop enhanced images were then 

split into channels (Image -> Color-> Split Channels). Only the green channel images were 

used for further analysis to quantify the axons with GFP. The green channel images were 

thresholded (Image -> Adjust -> Threshold) to approximately 50/255. Thresholding the 

image makes the image black and white and represents the image in total pixels. Total pixel 

images were skeletonized (Plugins -> Skeleton -> Skeletonized 2D/3D) to convert all axon 

width to exactly one pixel wide. ROI outlines from the ROI Manager were then overlaid 

onto the skeletonized images and were measured for total area of the ROI and for the total 

amount of pixels within the ROI. The total amount of pixels in the ROI were recorded as a 

decimal so that they could be multiplied to the total area of the ROI as a percentage, and 

then multiplied by 12 (the sections analyzed are 1 in 12) to account for the complete area 

represented by the section. This calculation resulted in the total area of the pixelated axons, 

or the total summed axon length in pixels, which was then converted to µms. The results 

were also calculated in total summed axon length per unit volume by first converting the 

total summed axon length and the total averaged area of the ROIs to µm3 and then dividing 

the former by the latter. Regarding nomenclature, total summed axon length refers to the 

total amount of µms within the specific ROI, and total summed axon length per unit volume 

refers to the total µm3s within the ROI divided by the volume of the ROI in µm3 to correct 

for large area bias and is comparable to axon innervation density. 
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Normalization of Results 

Four image stacks of the pyramid contralateral to the injected motor cortex were 

captured by a confocal microscope at 20x magnification with a step size of 2 µms. The 

pyramid was chosen for the normalization factor because all of the AAV-Cre has to come 

up through the pyramid as part of the CST from the spinal cord, and because the pyramid is 

easily anatomically defined. And this specific section of the pyramid (#42 of B2S3) was 

chosen due to its objectively average density of labeled cervically-projecting axons in 

comparison to the entirety of the sections with labeled axons. The four areas chosen for 

image stacks were the edge farthest from the ipsilateral pyramid, the bottom of the 

contralateral pyramid, the middle of the contralateral pyramid, and near the divide between 

the ipsilateral and contralateral pyramid, and were chosen because of their comparable axon 

densities.  

Fiji/Image J software was utilized to count all of the axons within each of the four 

image stacks using the “Cell Count” plugin. To make sure that axons were not double 

counted, a schematic of inclusion and exclusion lines was established to define which axons 

should be counted per stack (Fig. 2).  

The total area of the pyramid was calculated from an image of the pyramid captured 

by the Keyence BZ-X710 All-In-One Fluorescence Microscope at 2x magnification. The 

pyramid ROI was hand drawn onto the image and measured for total area in pixels and then 

converted to µms.  The conversion unit for converting pixels to µms was established by 

utilizing accepted scale bars in µms and the “Set Scale” function (Analyze -> Set Scale) in 

Image J to determine the corresponding number of equivalent pixels to µms. The area of the 

pyramid in µms was then multiplied by the average total number of axons in the pyramid 
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divided by the area of the field of view of the confocal microscope in µms, which 

culminated in a value of 1245.3 axons as the normalizing factor. Results in total summed 

axon length in µms and in total summed axon length per unit volume were then divided by 

this normalizing factor to calculate the normalized results. The calculated results for both 

total summed axon length and total summed axon length per unit volume were normalized 

for comparison to results in subsequent Rhesus macaque connectome projects. 

 

 

Figure 2. 

Modified stereological axon quantification method. Black ovals represent axon profiles at 

the upper face of the tissue section, and blue cylinders represent the remainder of each axon 

in the tissue section. The counting frame is bounded by green inclusion lines and red 

exclusion lines. The axon profiles at the upper face must fall within the counting frame or 
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on the inclusion lines, and not touch the exclusion lines. The five axons labeled A–E would 

not be counted. Axon A is not an axon of passage, because it runs primarily within the plane 

of section, rather than through it. Axons B and C touch the exclusion lines, while axons D 

and E are outside of the counting frame and do not touch the inclusion lines. (Rosenzweig, 

E., et al., 2009) 

 

Results 

Total Summed Axon Length 

Pixel quantification of the skeletonized images, reported as total summed axon length in 

µms, revealed the greatest total summed axon length in the pontine grey, closely followed 

by the thalamus, with the least total summed axon length in the caudate (F8, 110=4.326, 

p<0.001, Fig.3). The red nucleus, reticulotegmental pontine nucleus, and the zona incerta 

also had substantial axon presence, while the subthalamic nucleus, superior colliculus, 

putamen, and caudate contained the least amount of axon length. Most notably, the pontine 

grey and the thalamus significantly differed in total summed axon length from the caudate 

and the putamen, and the pontine grey significantly differed from the superior colliculus 

(Fig. 4).  
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Figure 3. 

Total summed axon length quantifications in the subthalamic nucleus (SB), thalamus (TH), 

zona incerta (ZI), reticulotegmental pontine (RTP), pontine grey (PGr), caudate (Ca), 

putamen (Pu), red nucleus (RN), and superior colliculus (Cs), normalized by a factor 

derived from the ipsilateral pyramid of the motor cortex. Bar heights represent total summed 

axon length sums within each region of interest. 
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Figure 4. 

The adjusted p-values of cross comparisons of total summed axon length in regions of 

interest (ROIs) from a One Way ANOVA Tukey’s HSD post hoc test. The regions of 

interest include the subthalamic nucleus (SB), thalamus (TH), zona incerta (ZI), 

reticulotegmental pontine (RTP), pontine grey (PGr), caudate (Ca), putamen (Pu), red 

nucleus (RN), and superior colliculus (SC). Adjusted p-values in red are less than 0.05. 
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Total Summed Axon Length Per Unit Volume 

Pixel quantification results were converted to total summed axon length per unit volume to 

correct for an area bias, which is most prominently visible in the thalamus and subthalamic 

nucleus (F8, 110=4.524, p<0.001, Fig. 5). The thalamus, which has the greatest total area of 

all the ROIs, experienced depressed representation of total summed axon length per unit 

volume compared to total summed axon length, while the subthalamic nucleus experienced 

inflated representation of total summed axon length per unit volume compared to summed 

total axon length (Fig. 5). Other ROIs also experienced changes in representation, such as 

the reticulotegmental pontine nucleus, zona incerta, and red nucleus which became 

comparatively inflated, while the caudate and putamen remained relatively the same. Also 

important to note is that the pontine grey, which reveals the greatest total summed axon 

length per unit volume, significantly differs from the caudate, superior colliculus, and 

putamen (Fig. 6). 
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Figure 5. 

Total axon density quantifications in the subthalamic nucleus (SB), thalamus (TH), zona 

incerta (ZI), reticulotegmental pontine (RTP), pontine grey (PGr), caudate (Ca), putamen 

(Pu), red nucleus (RN), and superior colliculus (Cs), normalized by a factor derived from 

the ipsilateral pyramid of the motor cortex. Bar heights and error bars represent means +/- 

se. 
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Figure 6. 

The adjusted p-values of cross comparisons of axon density in regions of interest (ROIs) 

from a One Way ANOVA Tukey’s HSD post hoc test. The regions of interest include the 

subthalamic nucleus (SB), thalamus (TH), zona incerta (ZI), reticulotegmental pontine 

(RTP), pontine grey (PGr), caudate (Ca), putamen (Pu), red nucleus (RN), and superior 

colliculus (SC). Adjusted p-values in red are less than 0.05. 
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Results Overview 

Discrepancy between the quantification results of the normalized total summed axon 

length and the normalized total summed axon length per unit volume illuminates the 

importance of correcting for the large area bias of the ROIs. For this reason, the normalized 

total summed axon length per unit volume was chosen over normalized total summed axon 

length to compare to the rat connectome data with greater accuracy. Using the normalized 

total summed axon length per unit volume quantification results for comparison is also 

beneficial because of the ability to calculate variance (+/- se) for the total mean axon length 

within each ROI, which cannot be done for total summed axon length as it reports axon 

length as sums as opposed to means.  

 

Discussion 

Comparison of normalized total summed axon length per unit volume in the Rhesus 

macaque to innervation density in F344 rats revealed the importance of the Rhesus macaque 

connectome in achieving closer resemblance to a human model for clinical relevance due to 

innervation density differences in ROIs.  

Both the Rhesus macaque and the rats express the greatest innervation in the pontine 

area (in Fig 5: Pon in rats, in Fig 3: RTP and PGr in Rhesus macaque) which is critical in 

hand movement as it relays information from the motor cortex to the cerebellum for 

intended contralateral movements of the arm and leg as part of the corticocerebellar pathway 

(Apps, et al., 2018)- making it credible that both the monkey and the rats would have the 

greatest innervation density in this area. Further highlighting the pontine area’s importance 

in hand function, sub-optimal functioning of the pons following a pontine based infarction 
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causes symptoms including ataxic hemiparesis and dysarthria-clumsy hand syndrome due to 

the pontine’s role in informational relay within motor movements to the hand (Kim, Lee, 

Im, & Lee, 1995). 

Beyond the pontine area, innervation densities within the Rhesus macaque and the 

rats differ in subsequent ROI quantities of innervation. In the monkey, the next greatest area 

of innervation after the pontine area is the red nucleus (in Fig 3 and 5: both RN). The rats 

also have slightly above moderate innervation in the red nucleus, but is just not as dense 

compared to other innervated regions. The red nucleus is involved in motor control via 

being a relay center from the motor cortex to the cerebellum, but is thought to have varying 

roles within motor function in different animals, most notably between bipeds and 

quadrupeds. In quadrupeds, such as rats and monkeys, both the parvocellular red nucleus 

and magnocellular red nucleus are fully developed, while in bipeds, like humans, the 

parvocellular red nucleus is well developed while the magnocellular red nucleus is believed 

to be relatively vestigial (In this study, the parvocellular red nucleus and magnocellular red 

nucleus are quantified together as the red nucleus). However, recent studies have shown that 

the human fetus and newborn have a well-developed semilunar magnocellular red nucleus, 

raising the possibility that tracts associated with this area may have played a role in the 

evolutionary advancement of bipedalism (Hicks & Onodera, 2012). This evolutionary 

hypothesis may explain the difference in innervation found in this study between rats, which 

are quadrupeds, and the Rhesus macaque, which are facultative bipeds.  

In rats, the area with the greatest innervation density after the pontine area is the 

subthalamic nucleus (in Fig 5: STN in rats, in Fig 3: SB in Rhesus macaque). The 

subthalamic nucleus plays a large role in motor function as it is considered to be one of the 
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main regulators of motor function related to the basal ganglia. This is emphasized by the 

inhibition (in animal models) or high frequency stimulation (in humans) of the subthalamic 

nucleus resulting in suppression of Parkinson’s symptoms including akinesia and dyskinesia 

(Benabid, 2003). The Rhesus macaque also has above moderate innervation in the 

subthalamic nucleus, but it apparently does not play as large of a role in motor function as 

the red nucleus.  Interestingly, innervation densities of the caudate and putamen, both areas 

that make up the basal ganglia, are both very low in the monkey compared to the other 

ROIs. This low innervation of the caudate and putamen may contribute to the decreased 

innervation in the subthalamic nucleus in the monkey compared to other areas because of 

the subthalamic nucleus’ connection with the basal ganglia for voluntary movement. Other 

studies confirm small amounts of innervation in the caudate, but it is surprising that the 

putamen has so little axon density in the Rhesus macaque given its known role in motor 

function and its abnormal function connection to Parkinson’s disease (Künzle,1975; Brooks, 

2004 ). 

 Other areas such as the thalamus (in Fig 5: VM, AV, VA/VL, Po, PF in rats, in Fig 

3: TH in Rhesus macaque) and zona incerta (in Fig 3 and 5: both ZI) were comparable in the 

Rhesus macaque and the rats with slightly above moderate innervation density in both. The 

thalamus functions as a relay center for motor information to pass through to multiple motor 

pathways. These pathways mainly originate in areas such as the cerebellum and the basal 

ganglia and ascend to the primary motor cortex. Because of the thalamus’ relay role in 

motor pathways, it makes sense as to why there is substantial innervation density within this 

area. The pontine area is also a relay center of motor movement, however it holds a much 

larger axon density than the thalamus. This may be accounted for by the pontine’s location 

https://www.sciencedirect.com/science/article/pii/0006899375903844#!
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in the brainstem, which is a necessary output area for the efferent response to the hand 

through the pyramids of the medulla, while the thalamus is located above the brainstem so is 

not as critical in the direct output of information. 

 The zona incerta also has high large widespread connectivity with neural centers. Its 

location ventral to the thalamus places it in a prime position to receive converging neural 

input from several major tracts to the forebrain (Watson, Lind, & Thomas, 2014). 

Interestingly, deep brain stimulation of the zona incerta has been shown to significantly 

improve Parkinson's disease symptoms, with a significant decrease in the Unified Disease 

Parkinson's Disease Rating Scale and adjusted “off-on” rigidity scores, better than deep 

brain stimulation of the subthalamic nucleus (Plaha, Ben-Shlomo, Patel, & Gill, 2006). This 

may be indicative of a greater importance of the zona incerta in voluntary movement than 

the subthalamic nucleus, despite the greater density of axons found in the subthalamic 

nucleus than the zona incerta in the present study. 

The superior colliculus was only observed in the Rhesus macaque and was found to 

have sparse innervation density. The superior colliculus is mainly associated with the optic 

tract and visual processes as the primary integrating center for eye movements. Innervation 

of this area may therefore be the result of integration of visual and motor input necessary for 

dexterous aim. And although not observed in the rat connectome study, it can be presumed 

that the rat would have greater innervation in the superior colliculus than the Rhesus 

macaque due to the superior colliculus being part of the neural circuit for sensorimotor 

information integrated from visual input and sensory information from rat whiskers (Castro-

Alamancos & Favero, 2016). 
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In this study all axons within the ROI were quantified rather than distinguishing 

between axons of passage and terminating axons. Innervation is usually defined as just 

terminating axons, however including the axons of passage may not be that detrimental 

given their role in motor function, especially in areas such as the pontine area, red nucleus, 

and thalamus which are critical relay areas for motor function modulation, signaling, and 

efferent response. If deemed necessary to only quantify terminating axons in subsequent 

Rhesus macaques however, it may be possible by immunohistochemically staining 

specifically for terminal boutons or by using the confocal microscope to produce a TIF from 

which terminal boutons can be better discerned.  

In expansion of this study, it would be informative for more ROIs to be quantified, 

including all of the ROIs observed in the rat study, into the spinal cord, and especially of the 

primary motor and primary somatosensory cortices. With the monkey brain cut into coronal 

sections, it was difficult to accurately identify where the primary somatosensory and 

primary motor cortices were located without the central sulcus visible as the identifying 

landmark. This may be achieved in future studies however by determining and marking the 

location of the central sulcus pre-sectioning. Furthermore, an overall objective of this study 

was to establish a protocol for quantification of innervating axons in more Rhesus 

macaques. 

Overall, the difference in innervation densities between the monkey and the rats 

underlines the necessity of a larger animal model, such as the Rhesus macaque, for more 

accurate extrapolation onto a human model. Identification of significant ROIs involved with 

motor function may improve targeting of treatments and rehabilitation after human SCI, as 

well as provide a baseline for comparison to post SCI. 
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Fig 5. 

Quantitative analysis of collateralization arising specifically from C8 projecting 

corticospinal neuron. Values shown represent the average across 4 animals +/- se (Conner, 
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M., Ovruchesky, E., Takashima, Y., Biane, J., Gibbs, D., & Tuskynski, M., manuscript 

under review). 
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